Advanced Serial Data Logger

Trust in Confidence!

PRINTED MANUAL

© 1999-2019 AGG Software
# Table of Contents

## Part 1 Introduction
1. About GPS Tracker Data Logger ................................................................. 1  
2. Glossary ................................................................................................. 2  

## Part 2 License, Registration and technical support
1. License ..................................................................................................... 4  
2. Limitations .............................................................................................. 5  
3. How to acquire a license ......................................................................... 6  
4. Support ...................................................................................................... 6  

## Part 3 Installation
1. System requirements ............................................................................. 6  
2. Installation process ................................................................................ 7  

## Part 4 Program use
1. Getting started ....................................................................................... 7  
2. Introduction ............................................................................................ 9  
3. Data flow diagram ................................................................................ 10  
4. Work complete ....................................................................................... 11  
5. Useful advices ....................................................................................... 11  
6. Configuration .......................................................................................... 12  
   - Serial port .......................................................................................... 12  
   - Serial (COM) port ............................................................................... 12  
   - Network connection .......................................................................... 17  
   - TCP/IP settings .................................................................................. 17  
   - SMS .................................................................................................. 25  
   - Configuring the SMS data source ..................................................... 25  
   - Additional parameters ...................................................................... 29  
      - Data view change ........................................................................... 29  
      - Date/time configuration ................................................................. 30  
      - Name and security ......................................................................... 31  
   - Log files ............................................................................................. 33  
      - Log rotation .................................................................................... 33  
      - Log file access ............................................................................... 36  
      - Log deletion ................................................................................... 37  
   - Modules .............................................................................................. 38  
      - Introduction & setup ...................................................................... 38  
      - OPC server .................................................................................... 42  
      - Tracker data filter .......................................................................... 45  
         - Introduction ................................................................................ 45  
         - Configuration ............................................................................. 46
1 Introduction

1.1 About GPS Tracker Data Logger

Devices that use GPS to locate an object and a GSM channel to send data to the user have become widely used lately. With GPS trackers, you can create a vehicle tracking system that allows you to track the entire route of a car or another vehicle. Besides information about the location, a GPS tracker can use additional sensors to send data about fuel consumption, traveled distance, velocity and car alarm.

It works in the following way: the GPS tacking unit uses a GPS or GLONASS receiver to determine its coordinates. The tracker reads data from sensors and generates a data packet containing all information about the vehicle. Then it uses the GSM transmitter or the GPRS data transfer channel to send the information packet to the server.

Our program GPS Tracker Data Logger acts as the server and allows you to collect data from an unlimited number of various GPS trackers simultaneously. The obtained data is processed, uniformed and written to a log file or a database. Also, the program has a set of interfaces so other applications can get data in real time.

Besides, GPS Tracker Data Logger can convert data into other formats (the formats of other trackers) and send them to other servers. It allows you to connect previously unsupported devices to existing systems or view data from heterogeneous GPS trackers with the help of integrated client software.

What problems can be solved with GPS Tracker Data Logger?

The advantages of using GPS vehicle tracking systems are undeniable as they allow you to considerably reduce your company’s expenses due to reduced expenditure on deviations from the route and prevented personal use of company vehicles.

Our program allows you to reduce the amount of client and server software being used thanks to the possibility to receive and process data from various trackers.

Key features:

- Various types of GPS trackers. Receiving, processing and exporting data from a lot of various GPS trackers at the same time.
- Universality. Receiving and processing binary and ASCII data packets.
- Receipt confirmation. GPS Tracker Data Logger can send data receipt confirmation packets to the GPS tracker.
- Advanced log file configuration. Logging received data to a file without any modification. A wide range of formatting log files (by time, date, etc.).
- Conversion. It is possible to convert data from all trackers to one format and retransmit them to another server (on request).
- Export to databases. Exporting data in real time to any ODBC-compatible database (MS SQL, MySQL, Oracle, MS Access, Interbase, Firebird and others).
- Integration. Plug-ins for writing to databases can work with tables of any structure. For special purposes, it is possible to write custom SQL queries, for example, for writing data to with the help of stored procedures.
- Fault-tolerant export to a database. For an additional fee, you can purchase the plug-in for exporting data to MS SQL, MySQL, Oracle, Interbase, Firebird that directly connects to the
necessary database without additional drivers and allows you to save data if the database is temporarily unavailable.

- Interfaces for receiving data. GPS Tracker Data Logger can work as a DDE or OPC server and pass all received data to other applications in real time.
- Data filter. The set of filtering plug-ins allows you not to write unnecessary data to the database or the log file. It is possible to specify complex conditions for filters with the help of scripting languages.
- Data modification. Additional plug-ins allow you to use formulas to calculate, correct and modify data before it is written to a database.
- Windows service mode. GPS Tracker Data Logger can also run as a service under Windows 2000 and higher. It allows the program to receive and process data in the background mode right after the operating system is started and before the user logs in. The program keeps running after the user logs off.
- Simple and intuitive interface. Neither programming nor special knowledge is required for the initial configuration of the program.
- It supports various operating systems. The logger runs on all versions starting from Windows 2000, including 32 and 64-bit systems.
- It is very easy to use! The configuration process is completely visual and has full context help. You can completely customize the application.

1.2 Glossary

**ASCII** - An acronym for American Standard Code for Information Interchange. ASCII files are plain, unformatted text files that are understood by virtually any computer. Windows Notepad and virtually any word processor can read and create ASCII files. ASCII files usually have the ".TXT" extension (e.g., README.TXT).

**Binary File** - A file that contains data or program instructions written in ASCII and extended ASCII characters.

**Bit** - A binary digit in the binary numbering system. Its value can be 0 or 1. In an 8-bit character scheme, it takes 8 bits to make a byte (character) of data.

**Bytes** - A collection of eight bits that represent a character, letter or punctuation mark.

**Cable** - Transmission medium of copper wire or optical fiber wrapped in a protective cover.

**Client/Server** - A networking system in which one or more file servers (Server) provide services; such as network management, application, and centralized data storage for workstations (Clients).

**COM port** - Short for a serial communication port. Most serial communication software communicates with a computer through a communication port, and most IBM and IBM-compatible computers support up to four serial ports COM1, COM2, COM3, and COM4. Additional ports can be added by adding additional hardware.

**Data bits** - A group of bits (1's and 0's) that represents a single character or a byte. Typically, there are seven or eight data bits. During an asynchronous communication (e.g., BitCom connecting to CompuServe), each side must agree on the number of data bits. Data bits are preceded by a start bit and followed by an optional parity bit and one or more stop bits.
DNS (Domain Name System) - A DNS server lets you locate computers on a network or the Internet (TCP/IP network) by the domain name. The DNS server maintains a database of domain names (hostnames) and their corresponding IP addresses. The IP address "8.8.8.8", corresponds to the DNS name www.google.com.

Flow control - A method of controlling the amount of data that two devices exchange. In data communications, flow control prevents one modem from "flooding" the other with data. If data comes in faster than it can be processed, the receiving side stores the data in a buffer. When the buffer is nearly full, the receiving side signals the sending side to stop until the buffer has space again. Between hardware (such as your modem and your computer), hardware flow control is used; between modems, software flow control is used.

Handshaking - is how the data flow between computers/hardware is regulated and controlled. Two distinct kinds of handshaking are described: Software Handshaking and Hardware Handshaking. An important distinction between the kinds of signals of the interface is between data signals and control signals. Data signals are simply the pins which actually transmit and receive the characters, while control signals are everything else.

Internet - A global network of networks used to exchange information using the TCP/IP protocol. It allows for electronic mail and the accessing ad retrieval of information from remote sources.

IP, Internet Protocol - The Internet Protocol, usually referred to as the TCP/IP protocol stack, allows computers residing on different networks to connect across gateways on wide-area networks. Each node on an IP network is assigned an IP address, typically expressed as ‘xx.xx.xx.xx’.

IP address (Internet Protocol address) - The address of a computer attached to a TCP/IP network. Every client and server station must have a unique IP address. Client workstations have either a permanent address or one that is dynamically assigned to them each dial-up session. IP addresses are written as four sets of numbers separated by periods; for example, 198.63.211.24.

LAN (Local Area Network) - A network, connecting computers in a relatively small area such as a building.

NIC, Network Interface Card - A card containing the circuitry necessary to connect a computer to a particular network media. Typically, the NIC plugs into the computer's accessory bus, (PCI, USB, etc.) and provides a network connection such as 10baseFL (fiber Ethernet), thin-net, AUI, etc.

PC - abbreviation for a Personal Computer.

Parity - In data communications, parity is a simple procedure of checking the integrity of transmitted data. The most common type of parity is Even, in which the number of 1's in a byte of data adds up to an even number, and None, in which a parity bit is not added.

Ports - is a connection point for a cable.

Protocol - is a formal description of a set of rules and conventions that govern how devices on a network exchange information.

RS232, RS423, RS422, AND RS485 - The Electronics Industry Association (EIA) has produced standards for RS232, RS423, RS422, and RS485 that deal with data communications. EIA standards where previously marked with the prefix “RS” to indicate the recommended standard.
Presently, the standards are now generally indicated as "EIA" standards to identify the standards organization.

Electronic data communications will generally fall into two broad categories: single-ended and differential. RS232 (single-ended) was introduced in 1962. RS232 has remained widely used, especially with CNC control builders. The specification allows for data transmission from one transmitter to one receiver at relatively slow data rates (up to 20K bits/second) and short distances (up to 50' @ the maximum data rate). This 50' limitation can usually be exceeded to distances of 200' or more by using low capacitance cable and keeping the data rates down to 9600 baud and lower.

**RTS/CTS Hardware handshaking** - uses additional wires to tell a sending device when to stop or start sending data. DTR and RTS refer to these Hardware handshaking lines. You can select whether you need to use DTR or RTS individually or use both lines for hardware handshaking. See also Xon/Xoff.

**TCP/IP, Transport Control Protocol / Internet Protocol** - TCP and IP are communications protocols, that is, structured languages in which data is communicated between one process and another, and between one network and another. TCP/IP is implemented in a multi-level layered structure.

TCP/IP is the 'glue' that ties together the many heterogeneous networks that make up the Internet.

**Stop bits** - In data communication, one or two bits used to mark the end of a byte (or character). At least one stop bit is always sent.

### License, Registration and technical support

#### 2.1 License

Copyright © 1999-2019 AGG Software.
All Rights Reserved

**SOFTWARE LICENSE**

**Trial Limited Version**

The trial limited version of this software may be used for evaluation purposes at the user's own risk for a trial period. At the end of the trial period, the user must either purchase a license to continue using the software or remove it from his/her system.

The trial limited version may be freely distributed, provided the distribution package is not modified. No person or company may charge a fee for the distribution of GPS Tracker Data Logger without written permission from the copyright holder.

**Licensed Version**
On payment of the appropriate license fee, the user is granted a non-exclusive license to use GPS Tracker Data Logger on one computer (i.e. a single CPU), for any legal purpose, at a time. The registered software may not be rented or leased but may be permanently transferred, if the person receiving it agrees to terms of this license. If the software is an update, the transfer must include the update and all previous versions.

Registered customers are entitled to free updates during one year from the date of purchase. It means that for one year you can download and install the latest registered versions of GPS Tracker Data Logger from our site. If you don't want to purchase an update, you can use the program forever; it will never expire, but you won't be able to use the latest version. If you purchased the software more than one year ago, you are no longer entitled to free upgrade and technical support; however, you can purchase an update to the latest version at a special, greatly discounted price, and this update will allow you to have free updates and technical support for another year. The type of the update license must match the type of your existing license.

Whilst every care has been taken in the construction and testing of this software, it is supplied subject to the condition that the user undertakes to evaluate the suitability of the control for his/her purposes. AGG Software makes no representation of the software's suitability for any purpose, and the user agrees that AGG Software has no responsibility for any loss or damage occasioned by the use of this software.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, THE SOFTWARE AND DOCUMENTATION ARE PROVIDED "AS IS" AND AGG SOFTWARE DISCLAIMS ALL OTHER WARRANTIES AND CONDITIONS, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, CONFORMANCE WITH DESCRIPTION, TITLE AND NON-INFRINGEMENT OF THIRD-PARTY RIGHTS.

TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, IN NO EVENT SHALL AGG SOFTWARE BE LIABLE FOR ANY INDIRECT, INCIDENTAL, CONSEQUENTIAL, SPECIAL OR EXEMPLARY DAMAGES OR LOST PROFITS WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR ANY OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE PRODUCT, EVEN IF AGG SOFTWARE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, AGG SOFTWARE'S CUMULATIVE AND ENTIRE LIABILITY TO YOU OR ANY OTHER PARTY FOR ANY LOSS OR DAMAGES RESULTING FROM ANY CLAIMS, DEMANDS OR ACTIONS ARISING OUT OF OR RELATING TO THIS AGREEMENT SHALL NOT EXCEED THE PURCHASE PRICE PAID FOR THIS LICENSE.

Should any term of these terms and conditions be declared void or unenforceable by any court of competent jurisdiction, such declaration shall have no effect on the remaining terms hereof.

If you do not agree to these conditions you should not install this software.

2.2 Limitations

The unlicensed program works in the trial mode. The program allows to test all features, but it limits the time and/or amount of processed data. The license key removes all limitations from the trial version. You may purchase a license key here.
The trial version of our software has the following limitations:

- The trial period is limited to 21 days. After that time, the program stops working.
- The continuous program work time is limited to two hours. After that period the program shows a message and stops working;
- All data export modules can handle the first 100 records only;

2.3 How to acquire a license

The unlicensed program works in the trial mode. The license key removes all limitations from the trial version and allows you to use our technical support for one year.

If you want to buy a program through the Internet, visit the order page of our site. On this page, you can get the newest information about the registration process, and also find an order link. Please, follow the “Buy now” link, enter your personal information, and choose the most convenient payment method for you. Further, you will get a notification and follow the notes in it.

You may find more information about our policies, payment terms, payment methods, and frequently asked questions on our web site.

2.4 Support

<table>
<thead>
<tr>
<th>Type of Questions</th>
<th>Email</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technical questions</td>
<td><a href="mailto:support@aggsoft.com">support@aggsoft.com</a></td>
</tr>
<tr>
<td>Common questions</td>
<td><a href="mailto:info@aggsoft.com">info@aggsoft.com</a></td>
</tr>
<tr>
<td>Sales questions</td>
<td><a href="mailto:sales@aggsoft.com">sales@aggsoft.com</a></td>
</tr>
</tbody>
</table>

3 Installation

3.1 System requirements

Windows 2000 Professional - Windows 10 (2019), including x64 and x86 OS, Workstation, and Server OS.
3.2 Installation process

If any beta-version was installed on your computer, remove it.

Quit of the working GPS Tracker Data Logger on installation time.

Run an installation file.

By default, the installation wizard installs GPS Tracker Data Logger to "C:\Program Files\GPS Tracker Data Logger" or "C:\Program Files (x86)\GPS Tracker Data Logger" the directory of your system disk, but you can change this path.

In the standard distributive of GPS Tracker Data Logger are no additional modules files, which you can download from our site.

4 Program use

4.1 Getting started

After you have successfully installed GPS Tracker Data Logger, use the following simple steps to configure and run it.

Open the GPS Tracker Data Logger program from the Start Menu.

At program run, you get into the main program window (fig. 1.1.1), main elements of which are the main menu, the data window, the program messages list, and the status bar.
- The data window shows incoming data before or after processing. You can configure the data view mode in the settings.
- The drop-down box at the bottom shows all logged program info, warning, and error messages.
- The status bar shows the current state of the selected data source, errors on the data interface, and how many bytes were sent or received.
- The toolbar above the data window provides fast access to the configuration.
- The main menu above the toolbar allows you to edit the program settings[9] ("Options -> Program settings..."), manage configurations, open the current logfile from the "File" menu (fig. 1.1.2).
By default (after installation), the program has not any data sources configured. If the list of data sources on the toolbar is empty, then the program will ask you to add a new configuration. Otherwise, the program will fill in the list of data sources and try to start logging of data sources configured. Yes, of course, all your settings are being saved while exiting from the program and loaded during the program start.

**Set-Up is as Easy as 1-2-3**

**Step 1.** Configure one or more data sources.

Click the "Add configuration" button on the toolbar with a big green plus and choose communication parameters for your device. The **Tab** of the "Configuration options" dialog lets you configure your settings.

**Step 2.** Configure log file.

Select the "Log file" header in the configuration dialog window and enable logging for a necessary data direction.
Step 3. Define how you want your data to be filtered and exported parsed and translated.

The "Plug-in" button on the toolbar in the main window or "Modules" tab in the dialog window lets you specify how to parse, filter and format your data to fit the exact format required by your application. It also lets you pre-define automatic output strings to be sent to an external device.

Now, the program processes and exports data from one or multiple data sources.

4.2 Introduction

The program can work with any network interface cards (NIC). Before configuring our software, the following conditions should be executed:

- If your computer has more than one network interface card (NIC) then GPS Tracker Data Logger will display a list of all the IP addresses for each NIC installed in your system so that you can select the IP Address that you want to use. In order for GPS Tracker Data Logger to act as a server, the computer that it is running on must have at least one network interface card with an IP address assigned to it.
- If GPS Tracker Data Logger will work as a server and your computer receives the IP address dynamically from a DHCP server, then you should ask your network administrator to assign a static IP address to your computer.

How to configure port parameters, you can read in the next "IP settings" chapter.

GPS Tracker Data Logger can save data to a log file(s) without any changes (i.e., create raw binary log files) or write to log files depending on the parser module selected. In the first case, you can view the log file with any hex editor and use this data for further analysis and remaking. In the second case, you can view data with any text editor. You can find more information about log files in the "Log rotation" chapter.

You can watch the data in the data window (fig. 1.1.1). The data view is fully customizable. You can watch data in decimal, hexadecimal, or your format. How to customize data view you can read in the "Data view" chapter and how to customize program view you can read in the "Window view" chapter.

The data can be exported or transferred to one or more targets. The simplest way is to configure the log file rotation. However, it is small a part of all features of GPS Tracker Data Logger. GPS Tracker Data Logger has many additional modules (so-called plug-ins) that are appreciably extending possibilities of the logging software. You can download and install any module supported. Most modules are free of charge for our customers. How to install and configure modules you can read in the "Modules" chapter.

The program and their plug-ins generate many messages and write them to the list in the main window (fig. 1.1.1) and a protocol file that you can use for administration of the software. You can also configure types of system messages. More information about it you can read in the "Protocol and errors handling" chapter.
4.3 Data flow diagram

This diagram may help you to understand the flow of data within our software and a place of each module. The following chapters describe all plugin types.

Fig. 1.2.1 Data flow diagram

History:

- The flow of binary data (RAW, unformatted data).
- The parsed data (formatted data). The data flow is separated into data packets and variables. Each data packet can be interpreted as a row, and each variable can be interpreted as a column.

Wires with other colors mark other relations with the unstructured data flow.
4.4 Work complete

The program saves all settings to the Windows registry when it stops working. All opened data sources will be automatically closed (unlocked, unallocated, or fried).

4.5 Useful advices

1. Look through hint helps on all window elements - it may help you to get a picture of this element’s function.

2. You can change all program settings without restarting the program. To transfer settings to another computer, you can do the following:

   1. Create a configuration backup from the “File” menu and restore it using the same menu.
   2. Alternatively, export the registry node with all program settings. Start regedit.exe and export the following registry node:

      on Windows x64
      HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\AGG Software\GPS Tracker Data Logger

      on Windows x32
      HKEY_LOCAL_MACHINE\SOFTWARE\AGG Software\GPS Tracker Data Logger

   3. On another computer import settings to the Windows registry.

   Many main window elements have "hot" keys for quick access to its functions.
   - Ctrl+S - analogs to click on "Start/Pause" button on the toolbar.
   - Ctrl+C - analogs to click on "Clear" button on the toolbar.
   - Ctrl+P - opens the window with the configuration settings.
   - Ctrl+L - opens the window with the log file settings.
   - Ctrl+W - allows you to configure the data view mode.
   - Ctrl+R - shows the window with the program settings.
   - Ctrl+E - shows the Windows 2000+ service settings.
   - Ctrl+M - here you can configure data query plugins, data parser, and other plugins.

4. You can look at the summary statistic that contains summary about sent and received data, created files, etc. (View - Statistics)

5. You can save program settings to an INI file. It may help to install and use several copies of the program. You can make your choice from the “Options” menu.

6. The program window can display only the last 10 messages. The full program log file (if activated) you can open using the “File - View program protocol file” menu item.
4.6 Configuration

4.6.1 Serial port

4.6.1.1 Serial (COM) port

COM port is short for a serial communication port. Most serial communication software communicates with a computer through a communication port, and most IBM and IBM-compatible computers support up to four serial ports COM1, COM2, COM3, and COM4. Additional ports can be added by adding additional hardware.

GPS Tracker Data Logger can manipulate with many serial ports at the same time (up to 255 serial ports).

You can open serial ports in GPS Tracker Data Logger software in two modes:

1. **Spy mode**. In this mode the program monitor data flow on ports selected. In this mode, GPS Tracker Data Logger intercepts all data exchange between any Windows application and external device.
2. **Standard**. In this mode, the program opens a serial port through Windows API functions, and read/write data from/to a serial port as a regular Windows application. In this mode opens a serial port with exclusive rights and other application will not have access to a serial port.

If one or more ports are configured already, then GPS Tracker Data Logger is opening these ports and starting logging. If the port is opened successful, then the status bar in the main window displays a status of this port (fig. 1.1.1). However, before you should configure serial port parameters. The configuration can include one or more serial ports with identical settings. For example, if you have many identical devices, that connected to different serial ports, then you can specify port numbers in one configuration only. However, if you want to use a serial port with different settings, then you should create more than one configuration.

You can create the new configuration by clicking the "Plus" button in the main window (fig. 1.1.1) or through the "Options" menu. After you clicked the "Plus" button, the dialog window will be opened (fig. 2.1.2). The dialog window contains few sections with parameters. The "COM port" section is described in this chapter.

You can manage the configuration created with a drop-down menu near the "Plus" button (fig. 2.1.1).
The "COM port settings" tab contains indispensable settings of any serial port: baud rate, data bits, etc. You should configure it with the same values, that your external device uses for data exchange.

![Fig. 2.1.2 COM port parameters](image)

If you are logging data over RS-485 with an additional hardware converter and your converter doesn't support data direction auto-detection, then specify "RS485 interface mode". This option instructs GPS Tracker Data Logger to set the RTS line at a low level while data receiving and vice versa. The serial port driver can detect errors while data receiving (for example, bad quality of a connection line). You can specify with the "At data receive error clean incoming buffer" option to ignore data blocks, that contain errors and clean an incoming buffer.

In some cases, the program can't open a serial port while starting (for example, the port is already used by other application). With the "Try to open after an unsuccessful attempt" option you can specify to try to open the serial port again after the interval specified. The program will try to open the serial port until an attempt will succeed.

**Check line status mode**

The Windows communication API provides two methods to check for received data and line/modem status changes: API calls (polling) and an event word. The event word is maintained by the Windows communications driver. As data is received or line/modem status changes occur, the driver sets bits in the event word. The application can check the bits to determine if any communication events
occurred. If so, the application can make the appropriate API call to clear the event word and retrieve 
the data or the new line/modem status values.

Windows also provides API calls to retrieve the same status information provided by the event word 
but the API calls are slower. GPS Tracker Data Logger uses the event word by default for the fastest 
possible performance. Unfortunately, there is at least one communication driver (WRPLDRV, 
included with some U.S. Robotics modems) that doesn't appear to support the event word. For this 
and similar drivers, select another mode before GPS Tracker Data Logger will receive data.

If you want to rise data transmit adequacy you can use hardware and/or software data flow control 
(fig. 2.1.3). When using hardware data flow control are used some lines (wires) of connecting cable. 
Depending on used lines, you must configure checks against corresponding fields.

**Hardware flow control**

When the hardware flow control options are an empty, as they are by default, there is no hardware 
flow control. The options can be combined to enable hardware flow control.

"Receive flow control" stops a remote device from transmitting while the local input buffer is too full. 
"Transmit flow control" stops the local device from transmitting while the remote input buffer is too 
full.

Receive flow control is enabled by including the "Use RTS" and/or "Use DTR" elements in the 
options. When enabled, the corresponding modem control signals (RTS and/or DTR) are lowered 
when the input buffer reaches the 90% size of the buffer. The remote must recognize these signals 
and stop sending data while they are held low.

As the application processes received characters, buffer usage eventually drops below the 10% size 
of the buffer. At that point, the corresponding modem control signals are raised again. The remote 
must recognize these signals and start sending data again.

Transmit flow control is enabled by including the "Require CTS" and/or "Require DSR" elements in 
the options. With one or both of these options enabled, the Windows communications driver doesn't 
transmit data unless the remote device is providing the corresponding modem status signal (CTS 
and/or DSR). The remote must raise and lower these signals when needed to control the flow of 
transmitted characters.

Note that flow control using RTS and CTS is much more common than flow control using DTR and 
DSR.

**Software flow control**

This routine turns on one or both aspects of automatic software flow control based on the value 
assigned to the property.

"Receive flow control" stops a remote device from transmitting while the local receive buffer is too full. 
"Transmit flow control" stops the local device from transmitting while the remote receive buffer is too 
full.

Receive flow control is enabled by assigning "On receiving" or "Both" to the "Type" property. When 
enabled, a Xoff character is sent when the input buffer reaches the 10% level of of the buffer size. The 
remote must recognize this character and stop sending data after it is received.
As the application processes received characters, buffer usage eventually drops below the 10% level of the buffer. At that point, a Xon character is sent. The remote must recognize this character and start sending data again.

Transmit flow control is enabled by assigning "On transmitting" or "Both" to the "Type" property. The 10% and 90% size of the buffer are not used in this case. When transmit flow control is enabled, the communications driver stops transmitting whenever it receives a Xoff character. The driver does not start transmitting again until it receives a Xon character, or the user sets software flow control to "None".

Software data flow control can be configured on receive, transmit, or both modes, but so as the great number of a device doesn't need data sending, select the "On receive" control mode. In case of activation of data transmit control, a remote object (your device) can send special codes, signalizing about data transmit stop or start. On default, received from device character 0x11 Hex signalizes to COM port driver to start data receive and character 0x13 Hex - to stop data receiving from a device.

![Configuration options](image)

**Spy mode**

In this mode, GPS Tracker Data Logger doesn't send and receive any data, and only spies on data exchange, made by other programs. You should enable the "Spy mode" checkbox.
Also, you must start the logger before any other program that can use the selected COM port.

After this, the logger will capture and show data exchange over the selected COM port in the main window.

Note: You must close the program you monitor, before closing GPS Tracker Data Logger.

**Serial data transfer errors**

Line errors can occur during data exchange and displayed in the main program window in the status bar.

UART receiver parity error - occurs if you configured an invalid parity type.

UART receiver overrun,
UART receiver framing error - occurs if you configured an invalid number of stop or data bits.

Transmit timeout waiting for CTS,
Transmit timeout waiting for DSR,
Transmit timeout waiting for RLSD - occurs if you configured invalid hardware flow control, or your serial interface cable isn't wired for hardware flow control.

Transmit queue is full - occurs if GPS Tracker Data Logger can't send data to a remote device.

Break - Break signal is received.

**Port restart**

You can also set the program to initiate the serial interface at the specified time. On some old versions of the Windows NT operating system it could help to avoid the loss of data when the program has been working for a long time without restarting. Please use the “Additional options” tab (fig. 2.1.4)
4.6.2 Network connection
4.6.2.1 TCP/IP settings

UDP vs. TCP

The most commonly used network protocols today are TCP (Transport Control Protocol) and UDP (User Datagram Protocol). TCP is a proven and reliable protocol, and probably the most widely implemented protocol in use on IP networks today. However, TCP has a lot of overhead and payload issues, and can sometimes be ‘too-reliable’ or robust for many applications. In fact, when used as transport, for many serial-based applications TCP can hinder reliable communications. In contrast, UDP is a much simpler protocol and is being used more frequently today - particularly in areas where bandwidth or throughput is constrained. An example is the predominant use of UDP for transport of wireless data applications.

UDP is first a connectionless protocol. Like TCP, UDP runs on top of IP networks. But unlike TCP, UDP does little to help with transport delivery or error recovery. Instead, it offers a direct way to send...
and receive packets, letting the software application manage things like error recovery and data retransmission. Once primarily used for broadcasting small messages, UDP is now used for everything from browsers to Instant Messaging, Video, and Voice over IP applications.

While a powerful tool, the downside to using UDP is that there is not ‘connection’ report to know that you have end-to-end connectivity. This often makes detecting whether or not a packet is ‘making it’ from one place to another quite a hassle.

**Client vs Server**

GPS Tracker Data Logger can be configured to log data from as many ports that you like simultaneously on a single computer. The program allows you to create multiple configurations for this task. Each configuration may contain different settings for each TCP/IP port. Each configuration has a set of TCP/IP parameters that are described below.

Each port configuration (i.e. TCP/IP connection) in GPS Tracker Data Logger can act as:

1. **Client.** You will need to specify the remote host IP address and the port number for the TCP/IP server that you want to connect to. The IP address that you specify in GPS Tracker Data Logger when configuring it as a client may also be either a URL or the name of a computer located on your network. For example, if you want to connect to a computer named "Plant1", you can simply enter "Plant1" for the IP address instead of the actual IP address. If you are configuring GPS Tracker Data Logger as a client and your network is set up to assign IP addresses dynamically to each workstation, then you may need to use the name of the computer that you want to connect to instead of an actual IP address to guarantee a connection.

2. **Server.** In this mode you should specify the IP address of the local computer will be used and you only need to specify the port number that you would like to use. If your computer has more than one network interface card (NIC) then GPS Tracker Data Logger will display a list of all the IP addresses for each NIC installed in your system so that you can select the IP Address that you want to use. In order for GPS Tracker Data Logger to act as a server, the computer that it is running on must have at least one network interface card with an IP address assigned to it. In Microsoft Windows, the TCP/IP protocol can be configured to automatically obtain an IP address from a host computer. It means that your computer may not have an IP address until it is connected to a network server or a host computer. You may need to contact your network administrator to assign an IP address to your computer if you wish to configure a TCP/IP server connection. This is done in the network settings for the TCP/IP protocol in your control panel.

After you enter the parameters that you would like to use, you must click the "OK" button to establish a connection between GPS Tracker Data Logger and the TCP/IP port. If the current port configuration is set up as a client, it will immediately try to establish a connection to the specified remote server. If the server is not available, GPS Tracker Data Logger will continually try to establish the connection until it is successful. If the port configuration is set up as a server, it will listen on the specified port until a client establishes a connection to it.

If one or more ports are configured already, then GPS Tracker Data Logger is opening these ports and starting logging. If the port is opened successful, then the status bar in the main window displays a status of this port (fig. 1.1.1). However, before you should configure port parameters that are described below.

You can create the new configuration by clicking the "Plus" button in the main window (fig. 1.1.1) or through the "Options" menu. After you clicked the "Plus" button, the dialog window will be opened
The dialog window contains few sections with parameters. The "IP settings" section is described in this chapter.

To log data from more than one TCP/IP connection, you would create and configure multiple port configurations. You can manage the configuration created with a drop-down menu near the "Plus" button (fig. 2.2.1).

![fig. 2.2.1 Access to the port configuration]

The "IP settings" tab contains indispensable settings of any TCP/IP port: IP address and port.
In addition to the IP address, you should specify how to connect to a remote machine. Our software can be thought of as a trunk line with thousands of individual lines (the ports) which are used to connect machines. Some ports are considered well-known ports. For example, the port typically used for network mail systems (SMTP) is port 25, the telnet port is port 23, the network news server port (NNTP) is typically port 119, and so on. To see a list of well-known ports, inspect the SERVICES file in the Windows directory (for Windows NT it is in the WINNT\SYSTEM32\DRIVERS\ETC directory). The SERVICES file is a text file used by GPS Tracker Data Logger to perform port lookups (which return the service name for the specified port) and port name lookups (which return the port number for the specified service name). You can open this file in any text editor to see a list of port numbers, and their corresponding service names. While these well-known ports are not set in stone, they are traditional and their use should be reserved for the service which they represent. When writing network applications, you should select a port number that is not likely to be duplicated by other applications on your network. In most cases, you can choose a port number other than any of the well-known port numbers.

The IP address and port number are used in combination to create a socket. A socket is first created and then is used to establish a connection between two computers. How the socket is used depends on whether the application is a client or a server. If an application is a server, it creates the socket, opens it, and then listens on that socket for computers trying to establish a connection. At
this point, the server is in a polling loop listening and waiting for a possible connection. A client application, on the other hand, creates a socket using the IP address of a particular server and the port number that the server is known to be listening on. The client then uses the socket to attempt to connect to the server. When the server hears the connection attempt, it wakes up and decides whether or not to accept the connection. Usually, this is done by examining the IP address of the client and comparing it to a list of known IP addresses (some servers don’t discriminate and accept all connections). If the connection is accepted, the client and server begin communicating, and data is transmitted.

Connection options

If the remote server (in the client mode) or local network interface (in the server mode) is not available and the “Try to connect after unsuccessful attempt” options is True, then GPS Tracker Data Logger will continually try to establish the connection until it is successful. The program will try to establish the connection every N seconds that you can specify in the “Next try after XXX seconds” field.

Allowed IP addresses

This option is active in the server mode and allows you to enter one or more IP addresses that have access to the server. The server refuses connections from any other IP address. This option is very useful if you transfer your data over an Internet connection or your server computer is connected to a big corporate network. You can specify multiple addresses - one per row. If you do not specify any address here, then GPS Tracker Data Logger will accept connections from all IP addresses.

Firewall settings

After you install Microsoft Windows XP Service Pack 2 (SP2), our GPS Tracker Data Logger may not seem to work. Windows Firewall, enabled by default, blocks unsolicited access to your computer via the network and may be blocking the normal operation of the program. To provide increased security to Windows XP users, Windows Firewall blocks unsolicited connections to your computer. When Windows Firewall detects incoming network traffic that it does not recognize, a Security Alert dialog box appears. The security alert dialog box looks like this:
The dialog box includes the following buttons:
- Unblock this program.
- Keep Blocking this program.
- Keep blocking this program, but Ask Me Later.

For our program to function properly, you must unblock the program by clicking the Unblock button. Unblocking allows Windows XP SP2 to allow the program to continue to work by adding it as an exception to your Windows Firewall configuration. Exceptions are specific programs and processes that you allow bypassing the firewall. After you add a program as an exception, you no longer receive the security alert. If you choose to continue blocking the program, certain functions will be disabled.

**Note:** If you are using another firewall software, then please, refer to a firewall manual for corresponding settings.

**Limitations**

The specific limit of connections is dependent on how much physical memory your server has and how busy the connections are:

**The Memory Factor:** According to Microsoft, the WinNT and successor kernels allocate sockets out of the non-paged memory pool. (That is, the memory that cannot be swapped to the page file by the virtual memory subsystem.) The size of this pool is necessarily fixed, and is dependent on the amount of physical memory in the system. On Intel x86 machines, the non-paged memory pool stops growing at 1/8 the size of physical memory, with a hard maximum of 128 megabytes for Windows NT 4.0, and 256 megabytes for Windows 2000. Thus, for NT 4, the size of the non-paged
pool stops increasing once the machine has 1 GB of physical memory. On Win2K, you hit the wall at 2 GB.

The "Busy-ness" Factor: The amount of data associated with each socket varies depending on how that socket is used, but the minimum size is around 2 KB. Overlapped I/O buffers also eat into the non-paged pool, in blocks of 4 KB. (4 KB is the x86's memory management unit's page size.) Thus, a simplistic application that's regularly sending and receiving on a socket will tie up at least 10 KB of non-pageable memory.

The Win32 event mechanism (e.g., WaitForMultipleObjects()) can only wait on 64 event objects at a time. Winsock 2 provides the WSAEventSelect() function which lets you use Win32's event mechanism to wait for events on sockets. Because it uses Win32's event mechanism, you can only wait for events on 64 sockets at a time. If you want to wait on more than 64 Winsock event objects at a time, you need to use multiple threads, each waiting on no more than 64 of the sockets.

If you have more than 64 connections at a time, then we recommend creating multiple configurations in our software (the "Green Plus" button). Each configuration will use different port number and will run in a different thread. This change will allow decreasing the influence of Windows limitations.

Additional parameters

The "Additional" tab contains additional settings of a TCP/IP or UDP connection (fig. 2.2.4).

Simple terminal emulation - the program realizes the simple implementation of some terminal protocols. If this emulation is enabled, then the program will process some special commands and character sequences.

Following options are effective only in the "TCP/IP server" mode:

Limit of simultaneous connections - you can define the number of clients that can connect to the server at the same time. It allows optimizing a server load with a large number of TCP clients.
Disconnect inactive clients after (s) - if a client is connected, but didn't send or receive any data within the specified time, then the connection with this client will be closed. If you will specify "-1," then the clients will not be disconnected.
Following options are effective only in the TCP/IP server or client modes:

TCP keep-alive mode

A TCP keep-alive packet is a short packet which is sent periodically by the OS to keep the connection alive. The connection stays alive because those packets and their replies generate small traffic on the connection when the application is idle.

Keep-alives can be used to verify that the computer at the remote end of a connection is still available.

It is simply an ACK with the sequence number set to one less than the current sequence number for the connection. A host receiving one of these ACKs responds with an ACK for the current sequence number.

TCP keep-alive can be sent once every KeepAliveTime (defaults to 7,200,000 milliseconds or two hours) if no other data or higher-level keep-alive have been carried over the TCP connection. If there is no response to a keep-alive, it is repeated once every KeepAliveInterval seconds. KeepAliveInterval defaults to 1 second. Some (buggy) routers may not handle keep-alive packets properly.

Our software supports three modes of keep-alive (fig 2.2.4):
1. **Off** - the program doesn't use the keep-alive feature at all. You can disable it if your network is very stable or your routers do not support it.

2. **System** - the program will use the keep-alive feature, but use system values of KeepAliveTime and KeepAliveInterval. These values are stored in the following registry branch:

   [HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\Tcpip\Parameters]
   KeepAliveTime (32-bit number) = milliseconds
   KeepAliveInterval (32-bit number) = milliseconds

3. **Custom** - the program will use keep-alive, but you can specify your values of KeepAliveTime and KeepAliveInterval, that are more applicable for your network and system. **Note**: in our software, you should define these values in seconds.

   **Note**: Some routers may not allow keep-alive TCP packets. In this case, the "keep-alive" function will not work.

### 4.6.3 SMS
#### 4.6.3.1 Configuring the SMS data source

During the configuration of how to receive incoming text messages, GSM modem(s) must be connected directly to the server where the program is running. The following requirements should be observed when you connect a GSM modem:

1. The modem must support the list of AT commands for handling text messages. The program checks the modem for compatibility during the initialization. If the modem is not compatible, no text messages will be received.
2. If the modem is connected to the COM port, you should specify the correct data transfer parameters (speed, data bits, etc.) (fig. 2.9.1)
3. If the modem is connected via the Ethernet, USB, Bluetooth interface or some other interface, drivers that create or emulate the modem COM port must be installed for this modem. The speed value does not usually matter for these modems.
It is possible to configure advanced modem options on the "Advanced options" tab (fig. 2.9.2).
Poll modem - if this option is enabled, the plug-in will query the modem every 3 seconds for new text messages. This mode is used if the GSM modem cannot notify the computer when a new text message is received.

Modem initialization - modem initialization string(s). It is a list of AT commands that are sent when a connection to the modem is being established. One command per line. For example:

- `AT&D2`
- `AT+CNMI=1,1,0,2,1`
- `ATE0`

In this case, the modem is configured to send notifications to the computer when a new text message is received.

Note: different initialization commands can be used for different types of modems, for example:

- Siemens: `AT+CNMI=1,1,0,2,1`
- WaveCom: `AT+CNMI=2,1,0,1,1`
- SonyEricsson: `AT+CNMI=3,1,0,1,0`
- Motorola USB modem: `AT+CNMI=3,1,0,0,0`
This command affects the process of receiving messages and receipt reports. If it is specified, you may get problems with receiving. That is why it is recommended to make sure that the parameters of this command correspond to the documentation of your modem. It is also possible to use other commands to optimize the operation of modems.

**How to configure modems**

Below you can see the instructions on how to preliminarily configure modems using Hyperterminal (the standard Windows program) or any other terminal software.

1. Connect the modem to the computer and wait till it is registered in the GSM network. Configure the modem port speed (as a rule, 9600 or 19200 bps), open the port.

2. Make sure the modem is active with the help of simple commands:

   ATZ (modem reset),
   ATI (manufacturer's identification),
   ATE1 (echo on).

3. Configure the modem for the correct text message transfer, check the text message transfer mode using the command

   AT+CMGF?
   the response should be
   +CMGF: 0,
   which means that modem is in the SMS PDU mode necessary for the plug-in to run, otherwise switch the modem into this mode using the command
   AT+CMGF=0
   the response is OK.

4. Configure the modem to save incoming and outgoing text messages to the SIM card using the command

   AT+CPMS?
   the response is +CMPS: "SM",0,20, "SM",0,20, "SM",0,20.
   If the response is different (for example: +CMPS: "ME",0,20, "SM",0,20, "ME",0,20), use the AT+CPMS="SM", "SM", "SM" command to enable the necessary configuration.

5. Save this configuration to the modem profile using the AT&W command.

6. Use the ATZ command to reset the modem and send the AT+CMGL=4 command (the response is OK or the list of saved text messages) to make sure that you have specified the correct settings.
## 4.6.4 Additional parameters

### 4.6.4.1 Data view change

**Configuration options**

![Configuration options](image)

**Data view**

Output type:
- Display data before parsing
- Display parsed values
- Display data after parsing

View characters with code:
- 0x00h - 0x1Fh: As Hex #XX code
- 0x20h - 0x7Fh: As some character
- 0x80h - 0xFFh: As some character

User's format:
- %d (shows to display a decimal code)
- %x (shows to display a hex code)

Highlight data sent on screen

Data source custom color

Split strings by data timeout (ms):
- 300

Split continuous data blocks large than (ms):
- 3000

Split by characters:
- #0A

---

### Data view settings, that can be configured on the "Data view" tab:

1. **View characters with code** - the program can interpret and decode bytes as characters. You can select decoding mode for each range of character codes. If the range doesn't have the corresponding character, that's why these data can be displayed only in hexadecimal and decimal code.
2. You can set up the **user's format** to display a data byte. The directive %d shows to display a decimal code, the directive %x - hex code. You can set any framing characters before/after the user format.
3. **Highlight data sent on screen** - a string with sent data will be highlighted by the selected color.
5. **Data source custom color** - if you've created several configurations then you can define a custom color for each data source that allows you to distinguish data flows on the "All data" page in the main window.
6. **Split strings by data timeout** - this option allows visually splitting data packets in the program window. Data packets that will be received after the specified interval will be shown on a new line. If this value is set to 0, then data packets will not be split.

7. **Split continuous data blocks larger than** - this option allows visually splitting continuous data flow in the program window. The program will show data on a new line if continuous data is longer than the specified number of bytes.

8. **Split by characters** - this option allows visually splitting continuous data flow in the program window using the specified symbols. For example (fig. 3.1.1), the program will use a character with the 0Ah hexadecimal code that is equal to the "LF" ASCII code.

### 4.6.4.2 Date/time configuration

This group of options (fig. 3.2.1) allows you to configure how timestamps appear in the log file and on the screen. You can configure the stamp format in the [program options](#).

![Configuration options](image)

**Date/time stamp**

- Add to display output for data sent
- Add to display output for data received
- Add if data direction has been changed
- Add for data packets (after parsing or split by characters)
- Add at begin of file

- **Stamp timeout (ms)**: 2000
- **File prefix/postfix character(s)**: < >

Note: Additional date/time stamp options are located in program options.

Main menu > Options > Program option > Date/time stamp

**Fig. 3.2.1 Time stamp configuration**

**Add to display output for data sent** - the time stamp will be added for the sent data displayed on the screen. The stamp will be added according to the timeout (if the data flow is uninterrupted) or when a data packet is sent.

**Add to display output for data received** - the same but for the received data.
Add if data direction has been changed - if the program is sending and receiving data, the time stamp will be also added when the data transfer direction changes (sending/receiving).

Add for data packets - if the data is displayed after it is processed, the stamp will be added to each processed data packet.

Add at begin of file - the stamp will be added at the beginning of every new log file.

Stamp timeout - if the data flow is uninterrupted, the stamp will be added regularly at the interval specified in milliseconds.

File prefix/postfix character(s) - the program will use these characters instead of those specified in the program options while writing data to a file. For example, it allows you to add the new line character or another sequence of characters before or after the stamp. Example: >#0D#0A

4.6.4.3 Name and security

This group of options (fig. 3.3.1) allows you to configure the following parameters:

Friendly name - this name will be added before the port number or the data source in the drop-down list in the main window of the program. It allows you to describe the data source.

Start logging automatically - if this option is enabled the program will start receiving and logging data automatically when it is launched.

The "Security" option group allows you to protect user operations in this particular configuration with a password. You can specify advanced security options applied to the entire program in the program options.

Ask password before start and stop - the password will be required when the user clicks the "Start/Pause" button in the main window of the program.

Ask password before configuration edit - the password will be required when the user tries to open the Configuration options dialog box.
Fig. 3.3.1. Name and security
4.6.5 Log files

4.6.5.1 Log rotation

The main function of GPS Tracker Data Logger is logging data to a file (so-called, log file). The "Log rotation" tab has a rich set of options for it. (fig. 4.1.1).

First of all, select log file what you can configure:

- **Log file for data received** - all data received will be saved using these settings.
- **Log file for data sent** - these settings will be used to save sent data. If you want to save data to the same file, as data received, then select the "Log file rotation for data sent" option from the list and enable two options: "Create log files on disk" and "Write to log for data received." Of course, you should configure a log rotation for data received before.

Set the "Create log file on disk" option to the checked state. Then you can set path to a folder, where files will be created with the help of a dialog window, which will be showed up after clicking a button with the "Folder" picture. You should select a necessary folder in the dialog window and click the "OK" button.
Log file path - the full path to a local or network folder, where the program will create new log files. The network path should be specified as: \COMPUTER NAME\Folder\n
Note: If the program works with network files, it greatly increases data flow through your network and decreases writing speed. Please, consider creating small log files. If your incoming data flow is fast, you may create log files locally. Later, you may sync a local folder with a remote folder using any 3rd party utility.

A log file name can be stamped with date and time. In this case, a new log file is created periodically. The format of a timestamp depends on the selected period. For instance, if the "File name prefix" field is set to "sample," the "File extension" field to "log," and the "File name format" option is "Daily," then each log file created will have the format "sampleYYYYMMDD.log". On March 21st, 2003, the log file will be "sample20030321.log". Please, note, that the final extension (after the final period), remains at the end of the file name.

Write to log - the option allows you to select when the program writes data to a log file. This feature is disabled in some loggers, and if the parser plugin is not available.

- Before parsing - the program saves all incoming data without any modifications. If an external device sends binary data, the logger will create binary files.
- After parsing - the program saves data after parsing. Generally, it is a parsed data packet.
- After filtering - the program saves data after all filter plugins. The logger saves the content of the "FULL_DATA_PACKET" variable. A filter plugin may transform or fully change the variable. If you do not use any filter plugin, then this mode works as the previous.
- Screen content - the program saves data to a log file as you see it in the main window. Generally, it is text content; therefore, the program creates a text log file.

The log rotation mode is defined by the following key parameters:

- File name prefix - the text string, which will be added at file name beginning. The prefix may contain special placeholders like {NAME}. If you create log files before parsing the NAME can be any date formatting values below. For example: "data{YYYY}_{MM}_{DD}" returns a prefix like "data2019_01_01". If you create log files after parsing or filtering, you may use any parser variable. Then the file name may depend on some value in your incoming data.
- File name extension - the text string, which will be a file extension (characters after the dot).

Limit size - the "Limit size" field specifies the maximum size in kilobytes of any log file. If you specify the zero file size, then the file size is not limited.

You may select from the following modes:

1. Clear file - if the log file size will exceed the limit specified, then the log file content will be deleted, and file filling will start from the beginning.
2. Rename old - if the log file size will exceed the limit specified, then the existing log file will be renamed.
3. Shift (no threshold) - the older data over the limit specified will be removed from the log file.
4. Shift (with threshold) - in this mode the program will wait when the file size will exceed the limit specified + the threshold value. After this, the older data over the limit specified will be removed from the log file.

If the program continuously works for a long time, it is possible that the log file will have a large size and this file will be inconvenient for looking and analyzing. Therefore, there is the possibility to create
files in dependence with the time on a computer. You can select one variant predefined or set up a new one:

- **Daily** - the file will be created with a name containing a prefix, and date in format DDMMYYYY, where DD is two-digit day sign, MM is two-digit month sign, and YYYY is four digits of the current year. The filename extension will be added at the end of the file.

- **Monthly** - the file will be created with a name containing a prefix, and date in MMYYYY format. The filename extension will be added at the end of the file.

- **Each data packet in different file** - in this mode, the program splits data flow to a different file. In this mode you should configure the parser or the program will split a data by timeout about 300 milliseconds.

- **Don't create new file** - in this mode, the program will write all data to one file. It is recommended for a small data flow. Otherwise, your log file will be too big, and a performance of the program will fall down.

- **User's format** - a file will be created with a name containing a prefix and date in showed by you format (for example, DDMMYYYY). The filename extension will be added at the end of the file. The file may not contain format signs, then file name will be constant. You should not use characters, that the OS doesn't allow in a file name, such as "/,\,*,?" and some others.

- **Weekly** - create a new file every week. The file name will contain a week number.

- **After data timeout** - the program will create a new file if the program didn't receive any data at the specified interval.

- **Hourly** - the file will be created with a name containing a prefix, and date in format YYYYMMDDHH, where HH is two-digit hour sign, DD is two-digit day sign, MM is two-digit month sign and YYYY is four digits of the current year. The filename extension will be added at the end of the file.

- **Constantly named file** - the current log file will have a constant name. When creating a new file, the existing log file will be saved using the new file name that will contain a date and time stamp.

**Date and time formatting codes:**

- D   - a day number (1-31).
- DD  - a day number with a leading zero (01-31).
- DDD - a day of the week in the text form (Mon-Sat), according to the regional settings on this computer.
- DDDD - a day of the week in the full text form (Monday-Saturday), according to the regional settings on this computer.
- M   - a month number (1-12).
- MM  - a month with a leading zero (01-12).
- MMM - a month name in the text form (Jan-Dec), according to the regional settings on this computer.
- MMMM - the full month name (January- December).
- YY  - last two digits of the year (00-99).
- YYYY - the full year number (0000-9999).
- H   - the hour number (0-23).
- HH  - the hour number with a leading zero (00-23).
- N   - minutes (0-59).
- NN  - minutes with a leading zero (00-59).
- S   - seconds (0-59).
- SS  - seconds with a leading zero (00-59).
Example: You want to create a log file every hour. It is desired that file name starts from "sample_log" and the file extension "txt".

Answer: set file prefix = sample_log_, file extension= txt (without dot!). In file name format show HHDDMMYYYY. Now the file will be created every hour. Naturally, you can set any formatting characters combination, described higher.

If you want to access to a log file while the program work, then you should configure access mode settings for the log file in the next chapter.

Add date/time stamp to file name - this option is available for modes #4 and #7 and allows adding date and time to the file name.

Add data source ID to file name - if this option is activated, then the program will append the data source name at the beginning of the file name, for example, COM1-sample20030321.log.

Write data/time stamp to file before writing data - if this option is activated, then the program will write a date/time stamp to a file before each data portion.

Overwrite existing files - this option is available for modes #4 and #7 and allows you to delete an existing log file before creating a new log file.

4.6.5.2 Log file access

During work can be such situations, when it is necessary to get access to a file with current data (current log file) from other applications (for example, for data processing). However, while you are accessing the current log file GPS Tracker Data Logger can't write data to a log file and all data at this moment will be lost. We recommend using a temporary file for data storage. It is the safest way. (fig. 4.2.1).
You can select one from the following variants:

- **Ignore and not write** - in this mode, the program stop writing to a log file until it is locked. Therefore, data will be lost.
- **Write to a temporary file, then append** - a temporary file will be created, to which writing will be done. After access to the current file will be got, temporary file content will be added to the end of the main file. However, mind that if file has a timestamp in the name, there can be a situation when the program copies the content of a temporary file to a new log file, for the next time.
- **Display a message and stop work** - data will be lost until the dialog window is closed.

You can define your message text, which will be displayed at writing error to a log file. The sound signal can be on for an additional indication. You can also enable writing a message to a protocol file.

### 4.6.5.3 Log deletion

The deletion of files (fig. 4.3.1) will help you to avoid stuffing your hard disk with needless information. Log files can be deleted either depending on the time of storing or when the maximal number of files is exceeded.
When deleting files by the time of their storage, the files that were modified last time before the specified period are deleted.

When controlling the number of files, the files with the oldest modification dates are deleted first.

You can select both variants of file deletion. In that case, files will be deleted when either of the conditions is true.

4.6.6 Modules

4.6.6.1 Introduction & setup

To extend program functionality, we implemented plug-in modules. The module structure lets you to reduce your program size and purchase costs (you pay only functionality, which you need).

GPS Tracker Data Logger supports a few types of modules (fig. 5.1.1 - 5.1.3):

- **Data query** - transmits queries or commands out the data source to control or query your devices.
- **Data parser** - the data parser allows you to parse, filter, and format data from your data sources. Some of the advanced features of the parser are the ability to work with raw binary or hex data.
- **Data filter** - data filters allow you to filter your data and modify a value of parser variables.
- **Data export** (fig.11) - GPS Tracker Data Logger has many modules and method for passing data to other applications, for example, there are modules for various databases, file formats (CSV, XML), data interfaces (OPC, DDE, MQTT), and many others.
- **Events handling** (fig.12) - these plug-ins are used to handle events generated by the GPS Tracker Data Logger software. Once an event occurs (for example, “Data source is opened” or “Configuration changed”), the plug-in creates a text message using the specified template, sends a notification, does some actions, executes a program or a script, etc. The form of the notification or actions depends on the plug-in settings.

![Configuration options](image)

### Query Parse Filter

<table>
<thead>
<tr>
<th>Module name</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aggregation (aggregator.dll)</td>
<td>4.0.28.1118</td>
</tr>
<tr>
<td>Deadband (deadband.dll)</td>
<td>4.0.27.1103</td>
</tr>
<tr>
<td>Expressions (expressions.dll)</td>
<td>4.0.34.1103</td>
</tr>
</tbody>
</table>

![Fig. 5.1.1. Activating plug-ins](image)
Fig. 5.1.2 Activating data export plug-ins
You can parse and export data sent and received (fig. 5.1.1). By default, only data received will be parsed.

**Installation**

You can easily install a new module. Usually, you should start the installation file and click the "Next" button for a few times. The installation wizard will detect a place of your GPS Tracker Data Logger software and place a plug-in module and all distributive files to the "Plugins" folder, which is in the program folder (by default X:\Program Files\GPS Tracker Data Logger\Plugins).

After the program restart, a module will be loaded and initialized. If the module is supported by our software, the module name will appear the modules list (Fig. 5.1.1-5.1.3). Most modules require additional settings. If you want to configure the plug-in module, click the "Setup" button near it. If you selected the module and the "Setup" button is not active, then the module doesn't have additional settings and can work without additional settings. Please, read a user's manual of the corresponding plug-in for additional information.

**Configuration steps**
1. Select and configure a query module. You may use a module of this type if you need to send some data to your device (for example, initialization strings or request strings).

2. Select and configure a parser module. This step is necessary because filter and export modules can use parsed data only. If you didn't select the parser module, then you can't configure the data filter and data export modules.

3. Activate and configure data export modules. You can select one or more modules simultaneously. The program will use selected modules simultaneously. Please, note, the program can't use the data export module, if you didn't configure the parser module.

4. Activate and configure event modules. You can select one or more modules simultaneously.

4.6.6.2 OPC server

Since the version 2.1.1 GPS Tracker Data Logger has an internal OPC server. It means that any OPC compatible client application can get data from GPS Tracker Data Logger without any additional software. To connect to the OPC server, you need the server ID and name (Fig. 5.2.1). Before using the OPC server on your computer, you should download and install the OPC Core Components Redistributable from www.opcfoundation.org (registration required).

GPS Tracker Data Logger parses all incoming data to one or more variables, and an OPC client gets it (fig. 5.2.2). After connecting to the OPC server, you will get a list of all variables.
Clients activity is showed on the "Active clients" tab. The top node is client, below is a group of items and connected items. By double-clicking, you can get detailed information about each node.
GPS Tracker Data Logger creates new variables at "on-the-fly" mode. The GPS Tracker Data Logger starts without any variables and gets it only after first data had been received. If your client OPC will connect to the OPC server before than data had been processed, then it will get an empty list of variables, and your OPC client should poll the OPC server for updating list of variables. If your OPC client doesn't allow it, then you can pre-define all variables (fig.5.2.4). In this case, the OPC server will create these variables with empty values, immediate after starting, and your OPC client will get these names while connecting.

<table>
<thead>
<tr>
<th>OPC server</th>
<th>All available active items</th>
<th>Active clients</th>
<th>Predelared items</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Client is connected: 1.27.0.0.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Group1</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>-- FULL_DATA_PACKET</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
4.6.6.3 Tracker data filter

4.6.6.3.1 Introduction

With the "Tracker Data Filter" data filtration plugin you can filter data from trackers by specified criteria. That allows you to cut the number of records in the database and respectively speed up the report generation. That improves the appearance of the route on the map when the tracker has difficulties receiving the signal from the GPS.

The basic rules allow verifying date, time, and coordinates validity, removing points with unessential changes.

The module filters for each tracker individually, discerning them by device unique identifier. With certain rules enabled the module stores information about the last received route point in its memory. That information is not kept (reset) when the application restarts or its settings are modified.
The configuration of the “Tracker Data Filter” module is very simple (Fig.1) and consists of just a handful of options.

Please note that the filtration is performed when any rule triggers. The module doesn’t perform the remaining checks if one of the rules has triggered already.

The checks are performed as follows:

1. Date and time check.
2. Coordinates check.
3. Speed check.
4. Distance check (minimum). Distance check is not performed if the received packet has invalid coordinates or timestamp lesser than the last stored value.
5. Distance check (maximum).

Filter out data where SPEED = 0 – when enabled, the module checks and filters out data with speed value (the SPEED variable) less than or equal to 0. The rule is handy when the tracker returns “floating” coordinates when the vehicle is parked – due to poor quality of the GPS receiver or weak GPS signal.

You can also specify exceptions when the filter does not trigger.
Pass first and last stop points down – when enabled, and incoming data is chronological, the module skips the first and the last stops, which may be sufficient for determining the parking interval.

Pass data down if one of the following variables was changed – when enabling this option, list the variables, separating them with semicolons. When the value of any of the specified variables changes, the filter skips the packet. This may be necessary for obtaining information about low battery charge during parking and with active alarms.

Filter out data with invalid coordinates – when enabled, the module filters out data if:

1. Latitude (the LATITUDE variable) or longitude (LONGITUDE) are absent in the data packet.
2. If the latitude value is outside the -90 ... 90 range.
3. If the longitude value is outside the -180 ... 180 range.
4. If both the latitude and the longitude values are equal to zero.

Filter out data with invalid date – when enabled, the module filters out data if:

1. The timestamp in the data packet (TIMESTAMP_UTC) is more than 24 hours greater than the server’s current time.
2. The timestamp is more than 365 days lesser than the server’s current time.

Filter out data if distance between points is less than – when enabled, the module calculates the distance between the previous and the current points by a formula. This allows disregarding minor points if the tracker sends them too frequently. For this rule, you can also set up exceptions, similarly to filtering by speed.

Filter data if distance between points is greater than – when enabled, the module discards data if the distance between the current point and the previous one is greater than specified (large spread). This sometimes happens if the device (mobile phone or tablet) can obtain its coordinates from both GPS and mobile base stations (A-GPS) or if the GPS receiver is defective.

4.6.6.4 Tracker data redirection

4.6.6.4.1 Introduction

With the “Tracker Data Filter” plugin, you can pass data from GPS trackers to other telematic servers and change the format (protocol) of the data on the fly.

The main logger application receives data from trackers of one type, splits the data into packets and variables, then the module assembles new data packets of the selected format and transmits it to the specified server over the TCP, UDP or HTTP(S) protocols.

Here is the list of currently supported formats; it expands continuously upon our customers’ requests.

APKCOM ASC 5
AutoGRAPH
EGTS protocol
Gis Sonic SOAP
GlobalTrack G200X
GMT SOAP
GpsGate SmartPipe (NMEA 0183 $GPRMC)
4.6.6.4.2 Configuration

In the Data redirection module’s configuration window (Fig. 1):

1. Select the format.
2. Specify the IP address and port of the server the data will be redirected to.
Match the variables in the parser with the respective fields in the data packet to be sent to the target server.

![Tracker data filter 4.0.31 build 415](image)

Fig. 1. Configuration window

Connection
**Formats** – select one or several formats. Individual settings will be used for each format. To activate a redirection in the required format, select the checkbox by the format name. To modify redirection settings for the required format, click and select it on the list.

**Target server** – specify the connection string for the required server. In this field, you can specify several target servers, separating them with a semicolon.

TCP – use the format 192.168.1.3:7777 (IP address followed by the colon and the port number).
Multiple servers: 192.168.1.3:7777;192.168.1.4:7777
UDP - udp://192.168.1.3:7777
HTTP - http://192.168.1.3:7777
HTTPS - https://192.168.1.3:7777

**New connection for each tracker** – the module emulates a real tracker by creating a new connection to the target server for each tracker. That increases CPU load but also improves compatibility, as not all target servers accept data from multiple trackers through the same connection.

**Maximum number of connections** – here you can limit the maximum number of connections to the target server. It is recommended to specify the limit value exceeding the number of working trackers by 20%. That way, the module will have enough time to transmit the live data being received from the trackers and restore the backed-up data from the archive in case of transmission failure.

**Backup data packets to folder if unable to send** – should any problems occur while transmitting data to the target server, the module will create temporary data files. When the connection is restored, it will both transmit the live data and restore the backed-up data.

Please note that in this case the chronology of the data transmission can be breached. Some target servers may be sensitive to the sequence of the data flow.

The module makes only five attempts to transmit data from the backup. Therefore, data loss is probable when the target server remains unavailable for too long.

**Log responses from target server** – this option may be useful when configuring or troubleshooting a connection to the target server. In the log files, you can view the server’s replies to the packets sent to it and, for instance, find out why the target server does not accept the data.

**Values**

On this tab (Fig. 2) you can match up the variables in the parser with the items in the new data packet in the selected format.
Please note that not all source data can be redirected to another server. In general, the redirection works only for the common telematic data (date, time, coordinates, speed).

By default, the redirection module is configured to transmit as much data as possible; however, you can change the content of the data to be transmitted by modifying the correspondence of the variables.

**Data packet item** – contains the list of all possible items in the new data packet.

**Parser item name** – specify the name of the parser variable, the value of which will be used when forming the data packet.

**Use default value** – if the source packet doesn’t have a variable with the specified name, the module will use the default value when forming the new data packet.

If there is no variable in the source packet, and the default value is not set, the new packet too will not have the respective value. If the target format does not allow skipping values, the program will add a zero, empty string or FALSE (depending on the field’s data type).

**Scale analog values** – the module can proportionally recalculate the source value into a new one. For instance, if in a new data packet, the value is an integer between 0 and 4096, the source value is 10, the minimum is 0, and the maximum is 100, the new value in the packet will be $4096 * 10 / 100 = 409$.

Table 1 lists the fields and their data types, which the module expects to receive from the parser. When matching up the values, you should keep in mind that the redirection module expects to receive data from the parser or the data filtration modules in the specified format. When matching up the values, the module can automatically convert their data types as follows:

- Float into integer by discarding the fractional part;
- Integer into float;
- Number into string;
- String into number;
- Number into a logical value (0 – logical FALSE, any other value – logical TRUE).

<table>
<thead>
<tr>
<th>Data packet field</th>
<th>Data type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IMEI</td>
<td>String</td>
<td>Device identifier (number, IMEI, etc.)</td>
</tr>
<tr>
<td>Date and Time</td>
<td>DateTime</td>
<td>UTC</td>
</tr>
<tr>
<td>Longitude</td>
<td>Float</td>
<td>In the GPS format; e.g., 48.71514</td>
</tr>
<tr>
<td>Latitude</td>
<td>Float</td>
<td>In the GPS format; e.g., 48.71514</td>
</tr>
<tr>
<td>Height (m)</td>
<td>Integer</td>
<td>In meters above the sea level</td>
</tr>
<tr>
<td>Heading</td>
<td>Float</td>
<td>Angle 0-360 degrees</td>
</tr>
<tr>
<td>Speed</td>
<td>Byte</td>
<td>Km/h</td>
</tr>
<tr>
<td>Distance</td>
<td>DWORD</td>
<td>Travel distance, km</td>
</tr>
<tr>
<td>Relay 1-8</td>
<td>Logical</td>
<td>Status of relay 1-8</td>
</tr>
<tr>
<td>Sensor 1-8</td>
<td>Logical</td>
<td>Status of sensor 1-8</td>
</tr>
<tr>
<td>ADC 1-4</td>
<td>Byte</td>
<td>Value of ADC 1-4</td>
</tr>
<tr>
<td>Voltage 1-2</td>
<td>Float</td>
<td>Voltage in Volts in the range between 0 and 25.5</td>
</tr>
<tr>
<td>GPS</td>
<td>Byte</td>
<td>Number of satellites (0 – 14)</td>
</tr>
<tr>
<td>GSM</td>
<td>Byte</td>
<td>GSM signal level (0-5)</td>
</tr>
<tr>
<td>T int.</td>
<td>Signed byte</td>
<td>Internal temperature (degrees) from -127 to 127</td>
</tr>
<tr>
<td>T ext.</td>
<td>Signed byte</td>
<td>External temperature (degrees) from -127 to 127</td>
</tr>
<tr>
<td>Fuel 1-2</td>
<td>DWORD</td>
<td>Value of fuel sensor 1-2</td>
</tr>
<tr>
<td>Engine hours 1-2</td>
<td>WORD</td>
<td>Value of engine hours 1-2</td>
</tr>
<tr>
<td>Alarm indication</td>
<td>Logical or numeric</td>
<td>0 or False – no alarm indication; otherwise, an alarm indication is present.</td>
</tr>
</tbody>
</table>

**Filter**

On this tab (Fig. 3) you can set up filters for trackers redirection is enabled for. The identifiers can be set in the module settings. You can also specify a name for the external text file.

If the text file name is specified, the module will check it occasionally and refresh the list in the memory when the file gets modified.

When the option "**Filter out specified IDs**" is enabled, the redirection will be enabled for all trackers except for listed in the table.

When the option "**Redirect specified IDs only**" is enabled, the redirection will be enabled only for trackers listed in the table.
Statistics

This tab provides brief performance statistics for the entire module (list of active and inactive connections). This data can be used for troubleshooting and obtaining information on the load of the redirection module. When the load is low, you can reduce the number of simultaneous connections and thus save CPU resources. Alternatively, the other way around, increase the number of connections if the outgoing queue is large.

4.6.6.4.3 Formats

APKCOM ASC 5, AutoGRAPH, GlobalTrack G200X, Navtelecom Signal 2115, Teltonika – format of the respective tracker.

EGTS protocol – Russian format EGTS.

Gis Sonic SOAP – example of a data packet with a link to the schema.

POST:application/soap+xml; charset=utf-8

```xml
<?xml version="1.0" encoding="utf-8"?>
<soap12:Body>
<GIS_Info_Sonic xmlns="http://portal.secureorigins.com">
<Security_Token/>
<device_num>3512340</device_num>
<Latitude>53.918460</Latitude>
<Longitude>27.603648</Longitude>
<timestamp>20190403061613</timestamp>
</GIS_Info_Sonic>
</soap12:Body>
</soap12:Envelope>
```

GMT SOAP – example of a data packet.
GpsGate SmartPipe (NMEA 0183 $GPRMC) – format of the data packet is the same as of $GPRMC of the standard NMEA 0183, but here the device ID precedes the packet.

IMEI=100000003512340$GPRMC,062147,A,5355.1076,N,02736.2189,E,21.6,0.0,20190403,,,E*4E<CR><LF>

GpsGate TrackerOne (HTTP) – format supported by the GpsGate system. Works only if the target server address is of the HTTP or HTTPS type.

GET /url?cmd=$FRCMD,100000003512340,_SendMessage,,5355.1076,N,02736.2189,E,0.0,21.60,0.0,030419,062350.00,1,Button1=1,Switch1=1,Analog1=-1.0*63 HTTP/1.1
Accept: */*
Connection: Keep-Alive
User-Agent: GPS Tracker Data Logger
Host: 127.0.0.1:7777

GpsGate TrackerOne (TCP) – format supported by the GpsGate system. Works over TCP.

$FRCMD,100000003512340,_SendMessage,,5355.1076,N,02736.2189,E,0.0,21.60,0.0,030419,062624.00,1,Button1=1,Switch1=1,Analog1=-1.0*65<CR><LF>

HTTP 1.1 GET - simple HTTP GET request.

GET /url?op=loc&imei=3512340&dt_tracker=2019-04-03+07%3A09%3A50&lat=53.918460&lng=27.603648&altitude=0&angle=0&speed=40&loc_valid=1&ip=127.0.0.1&port=7776&params=sat%3D9%7Cbatv%3D4.22%7Caccv%3D0.0%7Cdi1%3D1%7Cdo1%3D1%7C HTTP/1.1
Accept: */*
Connection: Keep-Alive
User-Agent: GPS Tracker Data Logger
Host: 127.0.0.1:7777

HTTP 1.1 POST - simple HTTP POST request.

POST /url HTTP/1.1
Accept: */*
Connection: Keep-Alive
Content-Type: application/x-www-form-urlencoded
User-Agent: GPS Tracker Data Logger
Host: 127.0.0.1:7777
Content-Length: 210

M2M SOAP – inter-server interaction protocol by Wialon.

<?xml version="1.0" encoding="windows-1251"?>
<soapenv:Envelope xmlns:env="http://schemas.xmlsoap.org/soap/envelope">

© 1999-2019 AGG Software
Wialon IPS, Wialon IPS v2 – protocols developed by Wialon. Detailed descriptions can be found on the Net. The second version of the protocol features additional fields in the first authentication message.

#L#3512340;NA<CR><LF>
#D#030419;071311;5355.1076;N;02736.2189;E;40;0;NA;9;NA;1;1;0.0,0.0;NA;serial_id:3:0,pwr_in:2:4.22,pwr_ext:2:0.0<CR><LF>

Wialon Retranslator – binary exchange protocol developed by Wialon.

4.7 Program options

4.7.1 Window view

This tab in program options (fig. 6.1.1) allows you to customize the appearance of the main window of the program (fig.1.1.1). You can access this tab through the "Options -> Program options" menu item in the main window.
You can set the following parameters:

- **Start in minimized state** - at start GPS Tracker Data Logger will automatically minimize the program window to the taskbar or to the Systray (fig. 6.1.2).
- **Minimize to Systray** - while the main window of GPS Tracker Data Logger minimizes, the program will automatically put its icon to the system panel near the clock.
- **Show data window** - if you specify this option, then the program will display all data in the main window. You may disable this option if you log data from many ports on a slow computer. It reduces the computer's CPU usage.
- **Output data on screen in minimized state** - if you'll enable this option, then the program will display processed data in minimized state. If you are logging many data sources on a slow computer, then you can decrease computer central processor load rate with disabling of this option.
- **Font type** - the data will be displayed with this font type in the main window. We recommend using mono-spaced fonts in this field, such as Terminal, Courier, or System.
- **Screen buffer** - when the number of lines in the main window exceeds the specified value, the program deletes old lines from the screen buffer.
- **Window view** - this option group lets you configure data window view mode (a font color, a font type, a background color).
- **Transparency** - in Windows 2000 and later lets you set the transparency of the main window. The most left position is the normal window view, and the most right position is maximum transparency.

- **Wrap words** - if you didn't configure a parser module or your data flow doesn't contain a blocks separator, then your data without this option enabled will be displayed as one long string in the data window.

Fig. 6.1.2 Systray - panel near clock
4.7.2 Date/time stamp view

This group of options (fig. 6.2.1) allows configuring the format of date/time stamps that will be used in the main program window and log files.

**Prefix/Postfix characters for display output** - these options allow you to define the beginning and ending characters of a date/time stamp that will be shown in the program window. When outputting data to a log file, the program uses individual characters for each configuration.

**View mode** - allows you to select the standard or define the custom format of the date/time stamp.

**Font** - this group allows you to define the color and font of date/time stamp.

**Add data direction sign to a stamp** - if this option is activated, then the program will append TX or RX to the end of the stamp.

**Add data source ID to a stamp** - if this option is activated then the program will append data source ID at the beginning of the stamp, for example, COM1.
4.7.3 Protocol and errors handling

While the program is running, it may generate many messages about errors or events. All these messages are being registered in a protocol file. The protocol file may contain messages from the main program and all working plugins. On this tab, you can define the kind of messages, which you want to put a protocol file (fig. 6.3.1). Here you can set the maximum protocol file size and the formatting mode.

Usually, the protocol file is in the "AppData" folder and has the name of the program with the 'log' extension.

On Windows 7 and higher: c:\ProgramData\GPS Tracker Data Logger\nOn old OS: c:\Document and Settings\All Users\GPS Tracker Data Logger\n
You can also open the protocol file from the “File” menu in the main window.

GPS Tracker Data Logger works with three types of messages:

- **Information messages** - this type of messages informs you about current operations.
- **Warnings** - warns you about possible failures or errors. Immediately user reaction is not required.
- **Errors** - the program has detected an error which requires user attention.

There is the possibility to log the following events:

- **Program messages** - messages about start or stop of the program, etc.
- **Data query** - messages which are generated in a data query module.
- **Data parser** - messages from a data parser module.
- **Data export** - messages issued by a data export module.
- **Other** - other message types.

You can write each type of messages to a protocol file or/and to the list in the main window. Please, specify necessary options for each message type at "Window" and "File" fields.

If you don't want to allow growing a protocol file size to an unlimited size, then you can enable the "Clean protocol at program start" or limit protocol file size in the "Size" field.

Some exceptional (unhandled) messages may occur while the program is running. In most cases, these messages affect the program, and the safest way is to restart the program. Please, specify the "Restart program at exception" option and the program will be restarted automatically.

If you want to look all program messages, then you can disable the "Don't display messages at unhandled exceptions" checkbox, and the program will open the exception message window with detailed information.

### 4.7.4 Service mode on Windows 2000+

#### 4.7.4.1 Configuration

Windows 2000+ services let you:

- Control service on local and remote computers, including remote computers with Windows 2000+ system.
- Setup actions on emergency service restore in case of failure, for example, auto service or computer restart (only on computers with Windows 2000 or later).
- Create for services other names and descriptions, to find them easier (only on computers with system Windows 2000 or later).
- Run service before user login (password input).
- Service can be configured on automatic start after operation system load.

*Note 1: you must be logged in as an administrator to change the configuration or control the service in any way (start, stop, pause, continue).*

*Note 2: On Windows Vista and later you should start the program with elevated administrator privileges.*

If you want to use the program as a service application, then, please, go to the "Options -> Program options -> Windows service" tab (fig. 6.4.1), then enable the "Use program as a service" checkbox. Later, please, specify the start-up type of the service. There are the following variants:
1. **Automatic** - the service starts automatically with Windows, before user login.
2. **Manual** - you can start the service application from the “Services” control panel (fig. 6.4.1).
3. **Disabled** - the service is disabled, and does not start at all.

If you want to change the program settings while the program works in the service mode, you can start a second instance of the program on your desktop, make the necessary changes, and restart the service with the new settings.

Old Windows versions (before Windows Vista) allows you to use the service in the interactive mode. In this case, the program places an icon in the system area (fig. 6.4.2).
If the service should write data a database or use another service on your computer, they should be started before GPS Tracker Data Logger. You can configure a list of these services on the "Program depends on services" tab (fig. 6.4.3).

![Fig. 6.4.3 Service settings #2](image)

Sometimes, you may need to start GPS Tracker Data Logger before starting other services. In this case, you should:

- Switch the start mode of a target service to "Manual."
- Start GPS Tracker Data Logger.
- Select the necessary service on the "Depending services" tab.
- Select the mode when the logger will start the selected service.
- Restart GPS Tracker Data Logger.

After you configured GPS Tracker Data Logger to work in the service mode, you need to restart a computer or start the service manually from the "Services" control panel (fig. 6.4.4).
When the service is running, two processes should appear in the Task Manager: gpstrackersrv.exe and gptracker.exe (fig. 6.4.5). The ‘gpstrackersrv.exe’ application implements an interface between the service manager and the GPS Tracker Data Logger software. Unlike srvany.exe utility, our service stops safely.
If you want to configure the program as a service, then you must be logged with administrator rights. The service application can be controlled, stopped, or removed with the help of a command-line. Run gpstrackersrv.exe with the following parameters:

- `/?` - a short help.
- `/I` - install service for starting in then manual mode.
- `/A` - install service for starting in the automatic mode.
- `/D` - install service in the disabled state.
- `/R` - remove service from the computer.

### 4.7.4.2 Windows Vista+ notes

One of the ways Vista's security was improved was by separating system services and user applications into separate 'sessions'. Keeping the system services isolated helps to secure them better, but also makes any interactive interface unavailable to the user. That's where the Interactive Services Detection service comes in. When a service needs to interact with the user, Interactive Services Detection presents a dialog that will switch the user to the session where the service is
running so they can interact with the service. For an excellent, detailed description of this, see next paragraph.

Many sites recommend disabling this service, but doing so will result in you not being able to interact with any services that require your attention. This service is run manually by default, so there is little point to disabling it unless you don't want to be bothered by important information from the software you may be trying to run.

- **Display Name**: Interactive Services Detection
- **Service Name**: UI0Detect
- **Process Name**: UI0Detect.exe
- **Description**: Enables user notification of user input for interactive services, which enables access to dialogs created by interactive services when they appear. If this service is stopped, notifications of new interactive service dialogs will no longer function, and there may no longer be access to interactive service dialogs. If this service is disabled, both notifications of and access to new interactive service dialogs will no longer function.
- **Path to Executable**: %windir%\system32\UI0Detect.exe
- **Default Start-up**:
  - * Home Basic: Manual
  - * Enterprise: Manual
  - * Ultimate: Manual

### 4.7.5 Restart & Security

Sometimes the program should be restarted. For example, if you've changed the program settings remotely and want to reload program automatically with the new settings. To do that, specify the time for restarting the program on the "Restart & Security" tab in program options "Options->Program options". Just specify the time of day, when the program should be being restarted.
On this tab, you can also protect some actions with the program by a password. To do that, activate the “Protect by password” option, define a password and select protectable actions.

6 Having problems?

6.1 Program doesn’t run or work

It is necessary to make sure in proper time installation on your computer, so as if you put clock after program installation, protection from use after trial period works.

Also, the program will not work, if you use a software debugger in your environment like WinDbg. In any other case, please, contact us on support@aggsoft.com.
6.2 FAQ

**Question:** Does the program work with virtual COM ports? USB-COM converters?
**Answer:** Absolutely!

**Question:** Why COM port doesn't open?
**Answer:** Probably, another program already uses it (the selected COM port). It can be a service application, for example.

**Question:** What to do?
**Answer:** Close the application that uses this communicative port (for a DOS application close also a DOS session window). Alternatively, use another communicative port. Probably, a COM port wasn't properly closed.

**Question:** Is it possible to set variable data transmit rate or transmit 9 data bits?
**Answer:** No, the Windows operating system doesn't have such the feature.

**Question:** What socket type to use: DB25 or DB9?
**Answer:** It does not matter. All modern computers have DB9 only. Alternatively, they do not have DB9 sockets at all.

**Question:** What cable do I need: straight or crossed (null-modem)?
**Answer:** It depends on your device. Generally, you should use a null-modem (crossed) cable with the following layout:

<table>
<thead>
<tr>
<th>Device</th>
<th>Computer</th>
</tr>
</thead>
<tbody>
<tr>
<td>RXD</td>
<td>TXD</td>
</tr>
<tr>
<td>TXD</td>
<td>RXD</td>
</tr>
<tr>
<td>GND</td>
<td>GND</td>
</tr>
</tbody>
</table>

If a device uses special signals like DTR or RTS, and you don't want to use hardware data transmit control, you need to connect pins 7 and 8 of the DB9 socket on the device side.

You can find more hardware related articles on our site [https://www.aggsoft.com](https://www.aggsoft.com).